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Nyheter

Nyheter i version 5.3 for programvaran TI-SmartView™ CE
Tillstandsfil

Forberedelse av tillstandsfilklass - Spara och ldsa in ett emulatortillstand

Anvand denna funktion for att hjalpa dig forbereda dina klasslektioner. Skapa ett "CE-
emulatortillstand" for varje klass som du undervisar. For att skapa ett CE-
emulatortillstand, mata in funktionerna i Y=, listor, program, berakningar for
hemskarmen eller det du vill visa pa emulatorn for klasslektionen i fraga. Nar du har
forberett CE-emulatortillstandet, spara tillstandet som en fil. Nar klassen borjar, las in
CE-emulatortillstandsfilen for klassperioden i fraga och bérja undervisa!

Se Actions (Atgirder) > Save Emulator State... (Spara
emulatortillstand...).

Se Actions (Atgirder) > Load Emulator State... (Lisa in
emulatortillstand...).

Nyheter
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Obs: CE-emulatortillstandet som du skapar, sparar eller laser in omfattar OS-versionen
for emulatorn vid tidpunkten du sparade filen. Denna funktion ar utformad for "precis i
tid"-forberedelse. Om dessa emulatortillstand anvands i framtiden efter att en CE OS-
uppdatering lanseras, lases tillstandsfilen in med samma OS-version vid tidpunkten da
du forst sparade tillstandsfilen och inte med en nyligen lanserad CE OS-version.

For mer information om de nya och uppdaterade funktionerna, ga till
referensguiden for TI-84 Plus CE pa education.ti.com/go/download.

2 Nyheter


https://education.ti.com/go/download

ACERIntroduktion till TI-SmartView™ CE-programvaran

Med TI-SmartView™ CE-programvaran kan du visa en TI-grafrdaknare for hela
klassrummet. Tva arbetsomraden &r tillgangliga for att hjdlpa dig att forbattra dina

presentationer i klassrummet.

&
L'jd
a

Arbetsomradet Riknaremulator

Har kan du:

Visa en Full Emulator-skarm eller en Knappsats
med stor skarm. Med alternativa vyer for att
Oppna eller stanga.

Tangenttryckningshistorik

— Visar bilder av nedtryckta tangenter sa att
elever kan félja med i tangenttryckningarna.

View3™

— Lararkontrollerad uppdatering av upp till tre
ytterligare emulerade skarmar sasom Graf,
Tabell och Ekvation for flera
representationer.

Berdkna och plotta

— Samma upplevelse som pa en fysisk
grafraknare.

Dra och slapp en emulerad skdrm till din
programvara for klasspresentation.**

— Bygg ut dina lektioner med skdarmar som
skapats under din undervisning.

Tryck pa emulatortangenter med en
Fjarrknappsats!

—  Kor SmartPad™ CE-appen*** pa din TI-84
Plus CE ansluten till datorn med din USB-
kabel. Nar fonstret TI-SmartView™ CE ar i
fokus pa din dator blir din raknare en
Fjarrknappsats.

Oppna ett separat Screen Capture-fonster

— Infanga och spara emulatorskdrmar som
datorfiler liknande TI Connect™ CE Screen
Capture, som infangar skarmbilder fran
grafraknaren.

** Programvara sasom Microsoft™ Office eller annan presentationsprogramvara

stods.

***Appen SmartPad™ CE for TI-84 Plus CE kommer foérladdad pa raknaren. Om inte
appen SmartPad CE finns pa din TI-84 Plus CE, sa finns den dven tillganglig for
nedladdning till din réknare fran education.ti.com/go/download.
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Obs: Skarmen Large Display ar inte pekaktiverad. Anvand emulatortangenter som pa
raknaren.

Skdarmen Riaknaremulator
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Arbetsomradet Emulatorutforskare

Har kan du:

o Lagg till enstaka eller flera filer till emulatorn for installning infor dina
lektioner:

— Dra valda raknarfiler och/eller dina bilder (jpg, png, etc.) fran din
dator till emulatorn fér snabb emulatorinstallning dven under
lektioner.

e Spara filer fran emulatorn for att spara till eller dela med dina
elevrdknare:

— Dra valda raknarfiler till din dator for att spara filer fran en
klasspresentation.

— Tips: Nar filerna har sparats till din dator kan du dra dessa filer till
anslutna elevraknare med Tl Connect™ CE Calculator Explorer for
klassrumsdelning. TI Connect™ CE ar fri for nedladdning fran
education.ti.com/downloads.

Standardskidarmen Emulatorutforskare

Fi- T1-SmartView™ CE for the TI-84 Plus Fa

File Edit

TI-84 Plus CE RAM: 152 kB available
0 NAME Tvee + smE LocaTION
i...N Window Window 2108 RAM
1N RelWindw User Zoom Recall Window 209 B RAM
1..N ThiSet Table Setup 208 RAM
02 X Real Number 98 RAM
¢ u Real List 28 RAM
¢ Real List 28 RAM
Yo Real List 28 RAM
¢ L Real List 28 RAM
¢} Real List 28 RAM
[ ™ Real List 28 RAM
D Prob Sim Flash Application 71 k8 Archive
@ Celsheet Flash Application 123 k8 Archive
@ Transfm Flash Application 25 k8 Archive
@ Cabrir Flash Application 102 k8 Archive
D Periodic Flash Application 46 kB Archive
@ sciools Flash Application 54 k8 Archive
N (O conics Flash Application 4248 Archive
s @ Plysmi2 Flash Application 87 k8 Archive
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Anvanda arbetsomradet TI-SmartView™ CE
Raknaremulator

Arbetsomradet TI-SmartView™ CE Raknaremulator innehaller verktyg som du kan
anvanda for att mata in berdkningar, plotta variabler och visa grafer, tabeller och listor.
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Omrdden i fénstret TI-SmartView™ CE Software

o

File Edit View Actions Help

Menyfélt - Anvand dessa menyer for att utfora alla emulatorfunktioner, inklusive:

e File (Arkiv) - filhantering e Actions (Atgarder) - sdsom infanga skiarm
e Edit (Redigera) - inkludera

kopiera tangent som e Help (Hjalp) - Hjalp och lankar

typsnitt
e View (Visa) - dndra

skdrmarna

Anmdrkning: Du kan utfdra de flesta atgarder pa dessa menyer genom att klicka
pa ikoner i verktygsfaltet.

Verktygsfalt - Anvand dessa verktygsikoner for att:

e Vilja en annan raknarmodell

e Vixla visning av Stor skirm, Knapptryckningshistorik P& eller Av samt View3™
e Infanga aktuell emulatorskdarm

Arbetsomradespanel - Anvand denna panel for att navigera mellan
arbetsomradena Calculator Emulator (Raknaremulator) och Emulator Explorer
(Emulatorutforskare).

Vilj positioner for Emulator och Verktygsfalt

e Emulatorposition vinster/héger E - for att vaxla mellan vanster- och
hégerhandsvisning av grafraknarens skdarm. Detta ar praktiskt vid projicering
av en interaktiv skrivtavla.

* Verktygsfilt topp/botten E - for att flytta verktygsfaltet mellan skarmens
over- och underdel. Detta ar praktiskt vid projicering av en interaktiv
skrivtavla.

Obs: Du kan dndra den visuella layouten och/eller positionen for element fér att
optimera atkomsten, sarskilt nar du anvander en interaktiv skrivtavia.

Emulatorpanel - Anvand denna panel for att anvanda denna fulla emulatorvyn
eller endast emulatorknappsatsvyn.

Stor skiirm / Knapptryckningshistorik - Anvand denna panel for att visa en stor
raknarskarm och/eller visa knapptryckningshistorik.

Du har féljande visningsalternativ:
e Large Display Screen only e Key Press History only (Endast
(Endast Stor skdrm) Knapptryckningshistorik)

e large Display Screen + Key Press .

History (Stor skarm + Hide panel (D3l] panel)

Anvdnda arbetsomradet TI-SmartView™ CE Rdknaremulator 7



Knapptryckningshistorik)

6 View®™-panel - Anviind denna panel for att samtidigt visa ytterligare tre
skdarmar. (Som forinstéllning ar denna panel dold. Klicka pa m for att visa

View3™-panelen.)
Du kan valja tre av foljande skdarmar:
e Equation (Ekvation e List (Lista) e  Window
("Y="-editor)) (Stat List-editor)) (Fonster)
e Table (Tabell) e Stat Plot e [Blank]
(Statistikplottning) ([Blank])

e Graph (Graf)

@ Andra storlek pa Paneler - Klicka pa och dra den vertikala listen pa sidan av en
panel for att andra dess storlek.
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Anviinda tangentbordet i TI-SmartView™ CE Emulator
Musen ersatter ditt finger vid tangenttryckningar pa datorns tangentbord.

Klicka pa tangenterna pa TI-SmartView™ CE-emulatorn pa samma satt som du skulle
trycka pa tangenterna pa grafraknaren.

1. Klicka pa piltangenterna "% pa emulatorns tangentbord for att flytta markéren

till 6nskad plats.

2. Klicka pa Tee for att vélja den.

Du maste forst stilla in tangentbordet i alfabetiskt skrividge for att skriva text med
datorns tangentbord.

Som forinstallning ar grafraknarens tangentbord i sitt normala lage, vilket innebar att
tangenterna helt enkelt ar kortkommandon for grafraknarens tangenter.

Att till exempel trycka pa [A] pa din dators tangentbord dr detsamma som att klicka pa
‘m pa grafriknaren. | detta ldge kan du inte skriva in bokstaverna A till O p3

grafraknarens skdarm genom att skriva dessa bokstaver pa datorns tangentbord.

For att skriva in en bokstav eller annat alfatecken, klicka forst pa & pa

grafraknarens tangentbord (eller tryck pa [F7] pa datorns tangentbord) for att stélla
raknaren i alfaldge. Om du till exempel skriver [F7] [A] pa datorns tangentbord sa
skrivs ett A in pa grafraknarens skarm. Nar du har skrivit in tecknet atergar
tangentbordet till sitt normala lage.

Du kan lI3sa alfatangenten for att skriva flera tecken i foljd.

For att I3sa alfatangenten:

> Klicka pa m ﬁ pa grafriknarens tangentbord eller tryck pa [F6] [F7] pa
datorns tangentbord.

For att aterga till normallaget:

» Klicka eller tryck pa [F7].

Att i alfaldge trycka pa [0] till [9] pa datorns tangentbord fungerar som
kortkommandon for de alfafunktioner som &r associerade med dessa tangenter pa
grafraknarens tangentbord. Trycker du pa [1] sa skrivs Y (alfatecknet associerat med
(1)) in pé grafraknarens skirm. For att skriva in ett tal, se till att tangentbordet inte &r i
alfaskrividge. Dessa tangenter skriver in siffrorna 0 till 9 i normalldget.

Du kan halla ned en piltangent for att kontinuerligt bladdra med markéren.

Na&r du anvdander en piltangent for att flytta markéren kan du halla tangenten nedtryckt
for att utan uppehall flytta markoren i stallet for att trycka pa tangenten upprepade
ganger. | tangenttryckningshistoriken och i ett skript har symbolen for en upprepande

piltangent en klocksymbol /ﬁé fast vid sig

Anvdnda arbetsomradet TI-SmartView™ CE Rdknaremulator 9



Nér du trycker pa en piltangent flera ganger i rad visas en pil med en
repetitionsraknare.

Na&r du trycker pa en piltangent flera ganger i rad visas en piltangent i
knapptryckningshistoriken. Denna piltangent, <%:\) , har ett nummer fast vid den som

visar hur manga ganger piltangenten har tryckts ned.

Tips: Nar du sparar langs grafer, eller anvander applikationen Cabri™ Jr App for att rita
geometriska former, kan du med pilarna pa datorns tangentbord fa en jamnare rérelse
jamfort med att anvanda en mus for att klicka pa emulatorpilarna.

Dra och sléippa en skédrm till en annan applikation

Du kan dra och slappa och klistra in valfri skarm i TI-SmartView™ CE i en annan
applikation.

Skarmarna i TI-SmartView™ CE som du kan dra och klistra in inkluderar foljande:
e Skdrmen ovanfor tangetbordet i Emulatorpanelen
e Stor skarm

3w

e Skdrmari View>™-panelen

Obs: Du kan dra en View3™-skirm till Screen Capture och anvinda Screen Capture
som en historik 6ver viktiga skarmar under en lektion.

e Sparade och ej sparade infangade skdarmbilder

10 Anvinda arbetsomrddet TI-SmartView™ CE Rdknaremulator



Ansluta en réiknare som en fjdrrknappsats

Appen SmartPad™ CE ar tillganglig for TI-84 Plus CE. For att anvanda
TI-84 Plus CE som en fjarrknappsats for TI-SmartView™ CE:

1.

Appen SmartPad™ CE for TI-84 Plus CE kommer forladdad pa raknaren. Om inte
appen SmartPad CE finns pa din TI-84 Plus CE, sa finns den aven tillganglig for
nedladdning till din réknare fran education.ti.com/go/download.

Anslut din TI-84 Plus CE till datorn med en USB-datorkabel som medfdljde din
raknare.

Starta TI-SmartView™ CE. Se till att TI-SmartView™ CE-fonstret ar aktivt genom att
klicka pa TI-SmartView™ CE-fonstret.

Kor appen SmartPad™ CE pa din TI-84 Plus CE. Tryck pa [apps] och vdlj SmartPad™
CE pa Apps-menyn. Las informationen pa skarmen.

NORHAL FLOAT AUTO REAL RADIAN HP [} HORFAL FLOAT AUTO REAL RADIAN HP [
wip TExas Q Texas
INSTRUMENTS INSTRUMENTS
SmartPad™ CE SmartPad™ CE
for TI-SmartView™ CE for TI-SmartView™ CE
. ITSTTIA UNPLUG USB CABLE ... ITESTTAUNPLUG USB CABLE
COMPUTER WINDOM OF EMULATOR COMPUTER HINDOW OF EHULATOR
MUST BE SELECTED MUST BE SELECTED
T0 PRESS EMULATOR KEYS T0 PRESS EHULATOR KEYS
.................. s e
- | @2006-2015 TEXAS INSTRUMENTS |

5. Tryck pa tangenterna pa raknarens knappsats som fjarrstyr emulatorns tangentbord
pa TI-Smartview ™ CE.

6. Koppla loss USB-kabeln fran raknaren for att stoppa appen och funktionen for
fjarrknappsats.

7. Du kan behova ansluta USB-kabeln och kéra appen pa nytt om anslutningen for
fjarrknappsatsen inte langre svarar.

Anmarkning:

TI-84 Plus CE som kor appen SmartPad™ CE visar inte berakningar eller grafer.
Réknaren fungerar da enbart som en fjarransluten USB-knappsats for emulatorn.

TI-84 Plus CE forblir en fjarrknappsats nar fonstret TI-SmartView™ CE ar aktivt.
Klicka pa TI-SmartView-fonstret innan du trycker pa raknarens tangenter.

Tl SilverLink-kabeln stods ej i TI-SmartView™ CE.

USB-datorkabel

Du maste anvanda USB-datorkabeln som medfdljer din TI-84 Plus CE grafréknare for
att anvanda appen SmartPad™ CE. Andra Tl-anslutningskablar stods ej.

Anvinda arbetsomrddet TI-SmartView™ CE Riknaremulator 11
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Ytterligare information om anslutningsmajligheter

e Menyn Emulator Link - Ingen sdndning/mottagning

Link-funktionen, [ink] p& emulatorerna ar avaktiverad. Fér att ldnka filer mellan
en ansluten raknare och en emulator, anvand Calculator Explorer i TI Connect™ CE
och Emulator Explorer i TI-SmartView™ CE.

Dra forst raknar- eller emulatorfiler till datorn vid 6verforing mellan Emulator
Explorer i TI-SmartView™ CE och Calculator Explorer i TI-Connect™ CE.

e TISilverLink-kabel
Tl SilverLink-kabeln stods ej i TI-SmartView™ CE.
o Aterstilla en riknare fran TEST MODE (testldges)instalining

TI-SmartView™ CE overfor inte en fil till en ansluten raknare. Se da till att skicka
filer mellan tva raknare eller anvand TI Connect™ CE for att skicka en fil till en
raknare i TEST MODE (testlage) for att inaktivera testldaget.

12 Anvdnda arbetsomrddet TI-SmartView™ CE Rdknaremulator



Aterstdlla emulatorn

For att aterstédlla emulatorn:

1. Klicka pa Actions (Atgirder).

2. Klicka pa Reset Emulator (Aterstill emulator).
3. Klicka pa Reset (Aterstill).

EN x|

Reset Emulator?

Resetting the emulator will overwrite all the
contents of the current emulator state, including al
items in RAM and Archive,

Do you want to reset the emulator?

CANCEL RESET

Aterstalla emulatorn:

e Skriver dver emulatorns aktuella status
o Aterstiller TI-SmartView™ CE-programvaran till fabriksinstaliningarna
e Rensar tangenttryckningshistoriken

Uppdatera emulator-OS — framat i tiden funktioner

Om det i framtiden finns en OS-uppdatering for en CE-raknare men TI-SmartView CE-
emulatorn inte uppdateras s& kan emulatorn uppdateras med Actions (Atgirder) >
Update Emulator OS... (Uppdatera emulator OS.... TI-SmartView CE krdver en sarskild
emulatortillstandsfil for att uppdatera emulator-0S. Den finns pa education.ti.com.
Denna fil ar annorlunda jamfort med filen du anvande for att uppdatera raknarens OS.

Anvinda arbetsomradet TI-SmartView™ CE Riknaremulator 13



Spara och lds in en CE-emulator Status

Nar du sparar ett CE-emulatortillstdnd skapas en fil som lagrar emulatorns
installningar med alla dndringar som du har gjort.

Du kan till exempel forbereda en klasspresentation genom att mata in funktioner i
"Y="-editorn och @ndra installningarna for Fonster och Zoom. Nar du sparar dina
andringar i en emulatortillstandsfil kan du helt enkelt Iasa in filen for att visa
presentationen. Om du vill skapa olika presentationer for olika klasser kan du skapa
flera tillstandsfiler for emulatorn.

Obs: Historik for tangenttryckningar, skdrmdumpar och emulatorns storlek sparas inte i
emulatorns tillstandsfil. Observera att tillstandsfilen fér CE-emulatorn kan vara stor.
Kontakta IT-avdelningen om lagringskapaciteten ar ett problem for dig.

Spara CE-emulatortillstandet

Att hantera, spara och ldsa in en fil for emulatortillstandet ar endast tillgéangligt for CE-
emulatorn. TI-84 Plus CE-emulatortillstandsfil kan endast ldsas in pa TI-84 Plus CE-
emulator.

1. Klicka pa Actions (Atgirder) > Save Emulator State... (Spara emulatortillstand...).

58 T1-SmartView™ CE for the TI-84 Plus Family
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2. | dialogrutan:
a) Navigera till den mapp dar du vill spara CE-emulatorns tillstandsfil.
b) Skrivin ett filnamn. Anvand ett namn som beskriver CE-emulatorns tillstand.
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CE-emulatortillstandsfilen har ett férkonfigurerat filnamn TI84PCE Emulator State_
0S 5-3-0_date.s84 dar filtillagget, *.s84 indikerar att filen ar ett TI-84 Plus CE
emulatortillstdnd skapad med TISmartView™ CE-programvaran.

c) Klicka pa Save (Spara).

Lasa in ett CE-emulatortillstand

Eftersom CE-emulatortillstandsfilerna ar specifika for varje raknarmodell kan du endast
lasa in en emulatortillstandsfil for den aktiva raknarmodellen.

1.

2.

Klicka pa Actions (Atgirder) > Load Emulator State (Lis in emulatortillstand).

8 T1-Smartview™ CE for the TI-84 Plus Family
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| dialogrutan:

a) Navigera till den mapp som innehaller emulatorns tillstandsfil.
Obs: Endast CE-emulatortillstandsfilerna for den aktiva raknarmodellen visas.

b) Klicka pa namnet pa CE-emulatorns tillstdndsnamn fér att markera filen.
c) Klicka p Open (Oppna).
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Viilja ett visningsalternativ

Du kan anpassa ditt visningsfonster sa att det visar eller doljer tillvalspaneler och dndra
typen av information som visas i dem. Som forinstallning visar TI-SmartView™ CE-
programvaran raknaremulatorns arbetsomrade i ldget Large Screen (Stor skdarm).

Visa rdaknarskdarmen

1. Klicka pa L:JJJ for att visa 2. Klicka pa L‘EJJ for att visa skarmen
raknarskarmen ovanfor tangetbordet i Knappsats + Stor skdarm.

Emulatorpanelen.

NORMAL FLOAT AUTO REAL RADIAN MP 1]

Vilja en emulatortyp

Klicka pa nedatpilen pa for att valja en emulatortyp.

v T84 Plus CE
T84 PlusC |

TI-84 Plus
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Varje emulatortyp visar dess relevanta raknarmodell.

Ti-84 Plus CE

stotplot 11 Siset 12 format f3 colc 14 table

y= | window | z00m | trace | graph
D@e -

S ,4'/'
DomeE &
111

Byta raknarens framstycke

For att byta framstycket:

1. Klicka pa View (Visa).

TI-84 Plus C Silver Edition
¥= | ‘wioow (zoom | (TRACE GRAPH
OO _C
)&

DD -~

TI-84 Plus Silver Edfition

@" ] '7 8 9 Cx

L o 4 - 5 6 =

@ 1 A 2 a) °F
0 =)

2. Hall markéren over Calculator Faceplate (Riknarframstycke).

3. Klicka pa namnet pa ett raknarframstycke.

Kontur

atstplot 11 nlunz ramm cﬂ: “

o=

Mork
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Visa eller délja tangenttryckningshistoriken

Klicka pa "-J'ﬂ for att visa eller dolja tangenttryckningshistoriken.

Klicka pa CLEAR (RENSA) i panelen intill tangenttryckningshistoriken for att rensa
historiken.

Key Press History
L5 U L& v 9

o Klicka har och dra for att andra Klicka har for att rensa
storleken pa tangenttryckningshistoriken.
tangenttryckningshistorikens
panel.

Na&r du trycker pa CLEAR ser du denna informationsruta:

E Key Press Histary = P4

Are you sure you want to clear the history?

CANCEL CLEAR

Kopiera tangenttryckningshistoriken till en annan applikation

Du kan kopiera alla eller utvalda delar av tangenttryckningshistoriken till en annan
L2 4

applikation, t.ex. en ordbehandlare. Du kan kopiera tangentgrafik sasom den
visas i tangenttryckningshistoriken eller ocksa kan du kopiera tangenttryckningar som

typsnittstecken [5] (=] (6].

Anmadrkning: Nar du kopierar tangenter som typsnittstecken anvander dessa tecken
teckensnittet TI84PlusCEKeys. Detta typsnitt installeras automatiskt i din dator nar du
installerar TI- SmartView™ CE-programvaran.

Kopiera tangenter som grafik- eller typsnittstecken

1. Valj den eller de tangenter som du vill kopiera.
For att valja tangenter i tangenttryckningshistorikens panel anvander du en av
foljande metoder:
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Knapp Metod
— Enenda tangent: Klicka pa en tangent.

—  Flera tangenter: Klicka pa en tangent.

Hall Ctrl-tangenten nedtryckt pa
datorns tangentbord.

Klicka sedan pa andra tangenter for att
vdlja fler.

— Flera tangenter i sekvens: Klicka pa en tangent.

Tryck och hall Shift-tangenten
nedtryckt pa datorns tangentbord.
Tryck pa en annan tangent.

Obs: Du kan harigenom vilja de tva
tangenterna plus alla tangenter
mellan dem.

— Alla tangenter: Klicka pa en tangent.
Hogerklicka.
Klicka pa Select All (Vilj alla).

Anmirkning: S3 har ser en tangent ut fére och efter att du har valt den.

Fore: Efter:

L2 2 L2 Z

EX

Hogerklicka pa de valda tangenterna.

Klicka pa Copy (for att kopiera tangenter som grafik).
- eller -
Klicka p& Copy As Font (for att kopiera tangenter som typsnittstecken). [5] (=] (6].

Véxla till en annan applikation.

Klistra in tangenterna pa lamplig plats.

Du kan ocksa dra de valda tangenterna som grafik till den andra applikationen.

Du kan dndra storleken pa tangentgrafiken nar du har klistrat in dem i en ny
applikation.

| vissa applikationer kan tecken inklistrade som typsnitt visas med det typsnitt som
anvands pa den aktuella platsen. Da kanske de inte alls ser ut som
grafraknartangenter. Vid behov, dndra till typsnittet TI84PlusCEKeys pa tecknen. Se
hjalpfilen for malapplikationen du anvander for information om hur du tillampar
ett typsnitt pa tecknen.

Anvinda arbetsomradet TI-SmartView™ CE Riknaremulator 19



Visa panelen View3™

1. Klicka pa m for att visa View3™-panelen.

2. Klicka pa titelfaltet pa varje skdarm for att valja mellan dessa visningsalternativ:

— Ekvation — Lista
("y="- (Stat List-editor)
editor)
— Tabell — Statistikplottning
- Graf

3. Klicka i den grona, lararkontrollerade uppdateringsknappen i View

— Fonster

— [Blank]

3m_panelen for

att uppdatera View3™-skirmarna. Detta uppdaterar vyn for dina elever under

undersokningar.

Uppdatering detekterad  Uppdaterar eller avbryt

Ingen uppdatering detekterad

4. Visa innehadllet pa de valda skdarmarna, eller upprepa steg 2 for att dndra skarmtyp.
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Andra storlek pé TI-SmartView™ CE-skérmen

Klicka pa och dra kanten pa en panel for att andra storleken pa panelerna Emulator,
Large Display (Stor skdrm) eller panelen View3™.

58 T1-SmartView™ CE for the TI-84 Plus Family (=1
File Edit

Key Press History m
# Toxas INSTRUMENTS TI-84 Plus CE

NORHAL FLORT AUTO REAL RAOIAN HP ) A lock s B @

Yi(-1)
4
9.8414709848, L enn-ysolve Adlock cale 4
EJ G (=)
i K == L
2 (el )

entry solve Graph ~

NORMAL FLORT AUTO REAL RAOLAN M? ]
enter

Equation

NORFAL FLOR AUTO REAL RAOLAN rP ]

stapiot (1 thisel 12 format 13 cale 14 table 15

(=] (wincow] (zoom | [trace) (oreph)

A— —

Table ~
NORMAL TLORT AUTO REAL RAOLAN MP ]
PRESS < FOR oTb1

2 v '
]

1 | ogus

H a4 |osess

H l ety

4 1 o.757

H 20 0.359

§ 51 | ezrs

7 W | oSy

& 59 | ossy

i % o1

R I )

E3
i
&

Anmaérkning: Alla dessa &r vinster/hogeratgarder med undantag for
tangenttryckningshistoriken som ar dra upp eller dra ned.
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Positioner for emulator och verktygsfiilt

Emulatorposition vianster/hoger - for att vaxla mellan vanster- och
hoégerhandsvisning av grafraknarens skdarm. Detta ar praktiskt vid
projicering av en interaktiv skrivtavla.

Verktygsfilt topp/botten - for att flytta verktygsféltet mellan skarmens
over- och underdel. Detta ar praktiskt vid projicering av en interaktiv
skrivtavla.

Alltid 6verst

Vilj detta alternativ (Alltid 6verst) pa View-menyn for att halla TI-SmartView™ CE-
fonstren over andra 6ppna datorprogramvarufonster. Detta ar som att ha réknaren
liggande pa skrivbordet ovanpa dina papper! Placera fonstret pa ditt datorskrivbord dar
det bast uppratthaller "Always in Front".

For att stanga av "Alltid 6verst," valj menyobjektet pa View-menyn. Det finns ingen
verktygsikon for denna funktion och ingen indikator utdver menykryssmarkeringen nar
funktionen ar aktiv.

Obs:

Arbetsomradet TI-SmartView™ CE Emulator och Screen Capture-fonster kommer bada
att vara "Alltid 6verst" och vaxlar beroende pa deras position.

"Alltid 6verst" rekommenderas inte nar du har full skarmbild eftersom alla andra
fonster kommer att vara bakom den fulla skarmbilden av TI-SmartView™ CE.
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Anvanda Skarmdump

Du kan infanga den aktuella grafrdknarens skarmbilder med TI-SmartView™-
emulatorns Screen Capture-verktyg.

For att anvanda funktionen Capture Screen:

> Klicka pa i verktygsfaltet.

Detta fonster 6ppnas:

E - TI-SmartView™ CE Screen Capture E@

Edit View Actions

O]
L

p

"Bcos(X)"¥Y1
JES SRS TUUPRUTRURPRRRRRRION P (= ) |-
"L 1KE-3"aY e

e ss s e DONE,
i
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Omrdden i fonstret Screen Capture

o

Infanga Klicka har for att infanga en bild av emulatorskdrmen:
Actions (Atgirder) > Capture Screen (och Capture Screen)
Anmarkning: En ram visas automatiskt runt varje skarmbild
nar du infangar den, men du kan ta bort ramen genom att
klicka pa View > Hide Screen Capture Borders (Visa> Gém
Screen Capture Borders). (Om du har flera bilder tar detta
bort ramen runt varje bild.)

Med Screen Capture kan du:

e infanga upp till 44 skdarmbilder at gangen (for att infanga
ytterligare bilder, ta bort bilder fran fonstret Screen
Capture).

e automatiskt lagra infangade skarmbilder i minnet tills du
stanger huvudfonstret i TI-SmartView™ CE.

Nar du stanger Screen Capture uppmanas du att spara dina

infangade skdarmbilder. Du kan starta en ny Screen Capture-

session under en TI-SmartView™ CE-session.

Spara Klicka har for att spara valda infangade skarmbilder:
File > Save As(Arkiv > Spara som)

Kopiera Klicka har for att kopiera valda infangade skarmbilder till
klippbordet:

Edit > Copy (Redigera > Kopiera)

Ta bort Klicka har for att ta bort valda infangade skdarmbilder:
File > Delete (Redigera> Ta bort)

© O OO0

Andra storlek For punkten langs skalan for att justera storleken i
granskningen av den aktuella infangade skdarmbilden.
View > Scale Screen Captures (Visa> Skala Screen Fangar)
Obs: Skdarmar sparas for den aktuella procentsatsen i vyn.

6]

Andra namn Andra namnet p3 en infdngad skarmbild genom att markera
titeln och skriva in ett nytt namn.

o

Visa Visa infangade skdarmbilder har.

Dra och sléippa en skédrm till en annan applikation

Du kan dra och slappa och klistra in valfri skarm i TI-SmartView™ CE i en annan
applikation.

Skdarmarna i TI-SmartView™ CE som du kan dra och klistra in inkluderar féljande:

Skarmen ovanfor tangetbordet i Emulatorpanelen

Stor skarm

3w

Skarmar i View>™-panelen

Obs: Du kan dra en View3™-skirm till Screen Capture och anvinda Screen Capture
som en historik 6ver viktiga skarmar under en lektion.
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e Sparade och ej sparade infangade skdarmbilder
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Anvanda arbetsomradet TI-SmartView™ CE
Emulatorutforskare

Fran arbetsomradet Emulatorutforskare kan du hantera emulatorfiler, lagga till
innehall fran din dator till emulatorn och skicka valt innehall till din dator.

L= TI-SmartView™ CE for the TI-84 Plus

T1-84 Plus CE RAM: 152 kB available
.'; NAME TYPE +  SIZE LOCATION
1. Window Window 2108 RAM
1N RelWindw User Zoom Recall Window 209 B RAM
1...N ThiSet Table Setup 208 RAM
0z x Real Number 9B RAM
{}u Real List 28 RAM
1w Real List 2B RAM
&} L Real List 2B RAM
-} u Real List 2B RAM
&} s Real List 2B RAM
[ P Real List 28 RAM
[ Prob Sim Flash Application 71 k8 Archive
[ celsheet Flash Application 123 k8 Archive
D Transfm Flash Application 25k8 Archive
D cabrinr Flash Application 102 kB Archive
@ Periodic Flash Application 46 kB Archive
@ sciTeols Flash Application 54 kB Archive
— @ Conies Flash Application 42k8 Archive
= 0 Plysmi2 Flash Application 87 kB Archive
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Delar av huvudfénstret TI-SmartView™ Emulator Explorer

e 6 O

Lagga till raknarfiler fran dator till emulator.

Ta bort valda raknarfiler.

Uppdatera vyn éver emulatorns innehall.

(1]
9 Skicka valda raknarfiler till dator.
(3]
(4]

Obs: Nar du dndrar arbetsomradet till Emulator Explorer, uppdatera vyn
av emulatorfilerna for att uppdatera eventuella andringar som gjorts i
emulatorn.

Kopiera emulatorfiler till datorn

Du kan kopiera de flesta data, filer och program fran din emulator till din dator som
backup-filer och sedan skicka dessa till andra réknare eller for att frigora minne i
emulatorn.

Kopiera en fil fran emulatorn till datorn

1. Klicka pa filnamnet for att vélja det.

2. Klicka pa .

- eller -

Dra och slapp filen i en mapp i din dator eller pa ditt skrivbord.
Kopiera en fil fran datorn till emulatorn
1. Klicka pa .
2. Navigera till 6nskad raknarfil i din dator.

Obs: Du kan ocksa dra dina bilder (.jpg, .png, etc.) for att konvertera till
emulator/raknarbakgrundsbilder.

3. Klicka pa filen for att vdlja den.

4. Klicka pa Open (Oppna).

Ta bort emulatorfiler

Du kan ta bort data, filer och program fran din emulator.

Ta bort filer fran emulatorn

1. Klicka pa filnamnet for att vélja det.

Anvinda arbetsomrddet TI-SmartView™ CE Emulatorutforskare
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2. Tryck pa .

Kortkommandon pa tangentbord

Du kan anvédnda din dators tangentbord for att trycka pa en tangent i stéllet for att
trycka pa den tangenten pa TI-SmartView™ CE-tangentbordsbilden.

Till exempel:

Om du vill 6ppna "log"-funktionen pa emulatorns tangentbord, anvand tabellen nedan
for att hitta vilken datortangent du ska trycka pa.

(o)

[M]

> Tryck pa [N] pa din dators tangentbord (och observera att emulatortangenten
upptill till vanster ar alfabokstaven N.)
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Kompatibilitet med grafréiknare
Se handboken Komma igang med din TI-84 Plus CE for kompatibilitet med grafraknare.

Anmdrkning: | regel ar grafraknarna T1-84 Plus CE kompatibla med andra TI-84 Plus- och
TI-83 Plus-modeller.

Appar, operativsystem och vissa datafiler med numeriska typer som ej stods delas inte
mellan modeller.

TI-Basic-program kan behéva modifieras for att korrekt visa hégupplosta
fargskarmsmodeller.
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Datainsamling med appen Vernier EasyData® pa
emulatorn for TI-84 Plus CE

Med appen Vernier EasyData® CE kan du anvdnda datainsamling pa emulatorn for TI-
84 Plus CE. Appen Vernier EasyData® CE for TI-84 Plus CE &r forinstallerad pa
emulatorn i TI-Smartview ™ CE. Med appen kan du samla in enstaka sensordata pa
liknande satt som med raknarens app.

Tips:

e Se till att du ar bekant med datainsamling med appen EasyData® pa rdaknaren
innan du anvander TI-SmartView™ CE for att samla in data.

e Se till att du ar bekant med menyn (File>New) for appen EasyData® CE eller
kortkommandot Scan. Du kommer att anvanda dessa funktioner i emulatorn for att
ansluta en sensor till emulatorn medan sensorn ar ansluten till datorn.

Anvéinda Vernier-sensorer med TI-Smartview ™ CE och appen

EasyData® CE

Om du redan anvander Vernier-sensorer med TI-84 Plus CE eller med produktfamiljen
TI-8 med en mini USB-port, kan sensorerna anslutas till raknarens mini USB-port.

Vernier-sensorer som ska anvandas med produktfamiljen TI-8x (mini USB) behover ratt
adapter for att ansluta en vanlig USB-kontakt till datorn for att demonstrera
datainsamling.

Adaptrar

Sensortyp som ska anslutas till datorn

Namn Adapter Beskrivning

Easy to Go! Anvand denna adapter for anslutning av
EasyTemp eller EasyLink™-adapter tillen dator
for datainsamling. Se mer

e
Gollink Anvéand denna enkanals granssnittsadapter for
att ansluta de flesta av Vernier-sensorerna till
datorn. Se mer
Go!Motion Anvind denna kabel for att ansluta Go!Motion
till eller CBR 2 tillen dator. Den medféljer
datorkabel Go!Motion. Se mer
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Sensortyp som ska anslutas till rdknaren

Namn Adapter Beskrivning

EasyLink™ Anvand denna adapter for att lanka Vernier-

By Link w\ sensorer till grafrdknaren TI-84 Plus CE.

" | EasyLink™ &r ett enkanals granssnitt som ansluts
tillUSB-porten pa grafraknaren TI-84 Plus eller
handenheten TI-Nspire™. Se mer

Golto Easy Anvand denna adapter for att ansluta Go!Temp
Adapter eller Go!Link™* till USB-porten pa handenheten
(mini USB) TI-Nspire™ eller grafrdknaren TI-84. Se mer
Go!Motion Anvdnd denna 72-tums kabel for att ansluta en
tillrdknarens Go!Motion eller CBR 2 till USB-porten pa
mini USB- handenheten TI-Nspire™ eller grafraknaren TI-
port . 4 84. Kabeln har en USB-kontakt av typ mini-A

~ =

som ansluts till rdknaren och en vanlig USB-
kontakt av typ B som ansluts till Go!Motion eller
CBR 2. Kabeln medféljer CBR 2. Se mer

Vid anvandning for klassrumsdemonstrationer

Datainsamling med appen EasyData® stdds for klassrumsdemonstrationer endast pa
emulatorn for TI-84 Plus CE . Om din klass anvdander nagon raknare ur produktfamiljen
TI-8x med den senaste versionen av appen Vernier EasyData®, kommer
demonstrationen av datainsamling med hjalp av TI-SmartView™ CE med TI-84 Plus CE
att vara jamforbar med upplevelsen pa TI-8x-réknaren.

Datainsamling fran en sensor

Datainsamling fran en enda sensor stods i emulatorn for TI-84 Plus CE (liknande
réknaren TI-84 Plus CE).

Om sensorn st6ds av appen EasyData® App pa raknaren via mini USB-kontakten, blir
emulatorn i TI-Smartview ™ CE ett demonstrationsverktyg for datainsamling som liknar
upplevelsen pa raknaren.

e (CBR 2™ (Calculator-Based Ranger™) stods med USB-kabeln.
e CBL 2™ (Calculator-Based Laboratory™ system) stéds inte.

e Den senaste versionen av appen Vernier EasyData® CE for TI-84 Plus CE ar
forinstallerad i emulatorn.

o Aldre versioner av appen ar blockerade i Emulator Explorer fér att fa den bista
upplevelsen av datainsamlingen.
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Anviéinda TI-SmartView™ CE for att demonstrera datainsamlingen
1. Starta TI-SmartView™ CE.

Tips: Om du kér ndgon annan programvara som ocksa samlar in data med hjalp av
Verniers USB-sensorer, rekommenderar vi att du stdanger alla andra
datainsamlingsprogram sa att TI-Smartview ™ CE kdnner igen den valda sensorn
for denna datainsamling. Annars kommer din dators operativsystem att
"bestamma” vilken sensor som ska kdannas igen. Du kanske inte ser din sensor som
ansluten till TI-SmartView™ CE férran du stanger andra program.

2. Klicka pa nedatpilen pa for att vdlja en emulatortyp.

3. Anslut en sensor till datorn via en vanlig USB-port.

Avancerade funktioner: Du kan ha flera sensorer anslutna till dina datorportar. Du
kan anvanda menyalternativet (Actions>Select Data Collection Sensor) i TI-
SmartView™ CE for vaxla mellan sensorerna. Anvand menyn (File>New) pa appen
EasyData® CE for att ansluta nya sensorer till emulatorn.

4. Kor appen EasyData® pa emulatorn for TI-84 Plus CE.

OBS: Den senaste versionen av appen Vernier EasyData for emulatorn for TI-84 Plus
CE (version 5.2 eller hogre) ar forinstallerad i TI-SmartView™ CE (v 5.2 eller hogre).

5. EasyData® startar pa emulatorn. Du bor se namnet pa sensorn (eller
lankanslutningen) pa valkomstskdrmen. Sensornamnet visas sedan i matarskarmen
pa ett liknande satt som i raknaren.

Om appen EasyData® inte kdnner igen den anslutna sensorn till datorn kan du
anvanda antingen Scan eller File>New i appen EasyData® pa emulatorn for att
ansluta sensorn.

6. Anvand funktionerna i appen EasyData® App pa samma satt som med CE-
emulatorn for att samla in och analysera data.

7. Avsluta appen (QUIT) EasyData® i emulatorn nar datainsamlingen ar genomfoérd for
att fortsatta anvanda TI-SmartView™ CE.

e Data fran datainsamlingen lagras i emulatorns listor nar du avslutar appen
EasyData® CE.

e Du kan lata sensorn vara ansluten till datorn sa lange du behéver.
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Medan appen EasyData® CE kérs pa CE-emulatorn kan du gora féljande:

Byta Du kan byta emulator medan EasyData® kérs men
arbetsyta pa  dataexperimentet stoppas och sensorn kopplas bort fran
emulatorn CE-emulatorn som kor appen EasyData®. Nar du atergar till

CE-emulatorn, kommer du att fa ansluta sensorn pa nytt
till appen EasyData® CE med antingen File>New eller
kortkommandot Scan i appen EasyData® och pabdrja en ny
datainsamling. Det &r inte sdkert att féregaende
experiments data lagras. Avsluta alltid appen EasyData®
med QUIT for att lagra experimentdata till emulatorns

listor.
View>™ och  View>™ ar inte tillgénglig (avaktiverad) for alla appar
appar férutom appen Inequality Graphing.
View3™ visar endast skirmar fran operativsystemet ™ och
visar inte app-skarmar. Vi rekommenderar att du behaller
View3™ stingd nir du inte anvinder funktionen eller d&
den &r avaktiverad som nar de flesta appar kors pa
emulatorn.
Byta till Om EasyData® kors i CE-emulatorn och du behéver
arbetsytan anvanda Emulator Explorer, avsluta da forst appen
Emulator EasyData® och anvand darefter Emulator Explorer.
Explorer
Infanga Du kan infanga skarmbilder fran appen EasyData® under
skirmbilder tiden som ett experiment utférs med Screen Capture.
Sting och Du kan stdanga TI-SmartView™ CE medan EasyData® kors
oppna pa men dataexperimentet stoppas och sensorn kopplas bort
nytt fran CE-emulatorn som kor appen EasyData®. Nar du
TI- atergar till CE-emulatorn, kommer du att fa ansluta
SmartView™ sensorn pa nytt till appen EasyData® CE med antingen
CE File>New eller kortkommandot Scan i appen EasyData® och

paborja en ny datainsamling. Det ar inte sdkert att
foregaende experiments data lagras. Avsluta alltid appen
EasyData® med QUIT for att lagra experimentdata till
emulatorns listor.

Ytterligare hjalp

Om du behéver mer hjadlp med att anvanda appen EasyData® med raknaren for att
samla in data, finner du mer information i
http://www?2.vernier.com/manuals/easydata_guidebook.pdf.
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Support och service

Texas Instruments support och service

Allman information: Nord- och Sydamerika

Hemsida: education.ti.com
KnowledgeBase och e-postfragor Webb: education.ti.com/support
Telefon: (800) TI-CARES / (800) 842-2737

For Nord- och Sydamerika och
amerikanska territorier

Internationella kontaktuppgifter: education.ti.com/support/worldwide

For teknisk support

Knowledge Base och stod via e-post: education.ti.com/support eller
ti-cares@ti.com
Telefon (ej kostnadsfritt): (972) 917-8324

For produktservice (maskinvara)

Kunder i USA, Kanada, Mexiko och amerikanska territorier: Kontakta alltid Texas
Instruments kundsupport innan du returnerar en produkt for service.

For alla andra ldnder:
For allmdn information

For mer information om Tl-produkter och service, kontakta Tl per e-post eller besok
webbplatsen pa Tl:s Internetadress

E-postfragor: ti-cares@ti.com
Hemsida education.ti.com

Service- och garanti-information

For information om langden och villkoren for garanti, se garantisedeln som medfdljde
denna produkt eller kontakta din lokala Texas Instruments-aterforsaljare/distributér.
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